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Chapter 1. Getting Started
Telia Touchpoint Flex Softphone makes it possible to place and receive calls using a comput-
er connected to the Internet and the Telia Touchpoint Flex. Besides offering basic functions
such as placing and receiving calls the application enables presence status management,
corporate directory search and instant messaging.

The main features are the following:

• Basic call handling - place, answer, record, hold and retrieve calls

• Call transfer

• Conference calls

• Directory search

• Presence handling

• Messaging and collaboration

A welcome Email will be sent to you by your system administrator containing the link to
download the application.

1.1. Installing
The application is installed by running a software installation package. When updating, the
installation package is opened automatically.

Before installing, complete the following steps:

1. Exit any previous versions of the application by selecting Exit from the File menu.

2. Close any Microsoft Office related windows.

Note

If you have set the security setting on Internet Explorer or from Control Panel to
High you need to add the server address to your trusted sites. See Section 1.1.1,
“Security settings” for more information.

1.1.1. Security settings
If you have set the security setting on Internet Explorer or from Control Panel to High you
need to add the server address to your trusted sites.

To add the server address to your trusted sites

1. Start Internet Explorer.

2. Select Tools > Internet Options.

3. Select the Security tab.

4. Select the Trusted sites icon.

5. Select Sites.
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6. Enter the server address given to you by your administrator. This would be in the format:
http://example.servername.com or https://example.servername.com.

7. Select Add.

1.2. Activation process
There are multiple options to activate the application.

Activate using a temporary activation code

1. From the activation view, fill in your username, your mobile number (including the country
code e.g.+46736123456) or your custom user identifier.

2. You might also need to fill in the server address if it was not embedded in the application.

3. Press Get activation code button. An activation code will be sent to you by SMS (in case
you provided mobile number) or by email.

4. Fill in the activation code and press Activate button.

5. If provided credentials are correct, your app is activated and should present you the main
view.

Activate using your password

1. From the activation view, press the Login with username and password option.

2. Fill in your username or your custom user identifier and your password.

3. You might also need to fill in the server address if it was not embedded in the application.

4. Press Login button.

5. If provided credentials are correct, your app is activated and should present you the main
view.
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Chapter 2. Getting to know the
application

2.1. Overview

Figure 2.1. User Interface Overview

Table 2.1. UI area

1. The toolbar contains shortcuts to call routing settings, inbox, contacts and con-
ference settings. The functions are also available in the Telia Touchpoint Flex
Web.

2. Your picture, presence, name, Caller ID, diversion info and note. Click on your
picture to see your vCard.

3. Live aid area. Here you will see notifications for missed calls, transfers, etc.

4. Search field

5. Tabs to switch between the different views.

6. Contacts/Calls/Log area. Each tab contains different information regarding con-
tacts, ongoing calls, and log.

7. Volume bar

8. Click to activate speaker/headset mode

9. Click to mute/unmute microphone

10. Click to switch which device to call from

2.2. Icons
There are many function icons in the application. This section lists a few of the most important
icons.
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Table 2.2. Presence icons

Icon Description

The contact's presence state is available

Contact is in a call

The contact's presence state is unavailable

Contact has a meeting that starts within 60 minutes according
to Outlook

Contact is in a meeting according to Outlook

Current activity end time available

Current activity end time expired

Contact has an activity diversion configured

Table 2.3. Active call icons

Icon Description

Opens a keypad for sending tones

Record the call

Stop recording of the call

Activate transfer

Add the call to a conference

Click to park the call

Pick up a parked call

Requeue call

Click to hold the call

Continue with the call held

Hang up the ongoing call

Encrypted call

Unencrypted call

The calling identity is asserted by the server

Move call to another phone
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Table 2.4. Other icons

Icon Description

Click to expand the contacts info

Click to call

Click to answer call

Start chat/Collaboration

Start chat/Collaboration (contact is away)

Send an SMS message

Intercom call

Incoming call entry

Missed call entry

Outgoing call entry

Edit the contact entry

Add the contact to your Favourites list

Remove the contact from your Favourites list

Delete local contact

Nightmode activated

New message in the Inbox

Logged in to an ACD or Attendant group

Logged out from an ACD or Attendant group

Call using desktop app (default)

Remote call control for deskphone call

Remote call control for mobile call

Speaker mode activated

Headset mode activated
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2.3. Tray Icon
When not used the application is minimized in the traybar. It is possible to change activity,
answer call, mute/unmute, hang up calls and exit in the minimized mode.
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Chapter 3. Calling

3.1. Call Panel Overview

Figure 3.1. Call Panel Overview

Table 3.1. Call Panel Area

1. Connected party's name

2. Connected party's vCard. Click to expand or
collapse. You can click the email icon to open
your email client.

3. Connected party's number and duration of
call. Short number is presented if available.

4. Mid-call options

5. Sign if the user is asserted by the system and
call state. The call state shows whether the
call is ringing, connected, on hold, etc.

6. Encryption. The padlock indicates whether
the call is encrypted (closed) or not (open).
Encrypted calls is a security setting enabled
by the system administrator.

7. Network quality measured on the caller side
as well as on the called party side

3.2. Line state

When a contact is in call this is indicated by the Line Busy icon  in the contact list.

3.3. Placing a call

3.3.1. Caller ID



Chapter 3. Calling

Revision: 4.7.15.46 8

The Caller ID displays which number that will be presented when doing a call. Your current
Caller ID is displayed next to your presence.

The following outbound numbers can be set (not all may be enabled for you):

• Primary line

• Secondary line

• Switchboard number

• Anonymous

• ACD and Attendant numbers

Setting a new Caller ID is very easy:

To set a new Caller ID

1. Click on the current Caller ID

2. In the list that pops up, choose a new Caller ID

3.3.2. Normal call
Search for a contact using the contact list and click Dial number from the contact panel or
enter a name or number in the search field and press the return key. If you enter a name
you will need to select the contact, for example with your arrow keys, before pressing the
return key.

The call button will change depending on which device that you will call with. For example, the
desktop app , a deskphone  and the mobile . See the call with section for more information.

You can also search for department or information in the free text fields. Your administrator
sets which fields that are available to search in. The search result will show what field or
text you match on.

It is possible to make a call even if there is an incoming call.

3.3.3. Intercom call

Search for a contact using the contact list and click Intercom Call  from the contact
panel. The sound will only be one-way, so the caller can not hear the recipient. The Intercom
call button is only available when the contact has at least one device that supports Intercom.

Note

Intercom call may not be allowed to all users even though the Intercom call button
is shown. This will result in an error when trying to place the call.
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3.3.4. Advanced calling options
The advanced call options for the application include Diversion bypass, Intrude ongoing call,
Call with role, and Call with selected device. The options are available in the Call menu option.

3.3.4.1. Bypass diversion rules

Selecting Bypass Diversion rules  will override any diversion set on the calling party. This
option is only effective for the next call.

Note

Diversion bypass may not be available for all users. The service is only available
to users that are authorized to bypass diversion.

3.3.4.2. Intrude ongoing call

Selecting Intrude ongoing call will intrude a call if the line is busy. This option is only effective
for the next call.

Note

Intrude ongoing call is not be available for all users. The service is only available
to users that are authorized to intrude ongoing calls.

3.3.4.3. Call As

Calling with a role can be used when you want to make a call and want a specific number
to be presented to the calling party. For example, if you work within a support division it is
possible to call with the role support and let the number associated with the support division
be presented to the calling party instead of your own private number.

Select a role from the Call as list to call with a role. This option is only effective for the next
call. Once the call is made, the role is reverted back to the current role. See the Roles section
for more information.

3.3.4.4. Call With

Call with can be used if you want to set up your call using the application but want to handle
the actual call using another device, for example a mobile phone or a desktop phone.

You can see which device you will call with in the bottom left corner of the Telia Touchpoint
Flex Softphone. In the following picture the user calls with mobile phone.

Figure 3.2. Call with setting
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Click on the icon to choose which device you should call with. You can also configure call
with using the Call > Call with setting in the Telia Touchpoint Flex Softphone. For example,
if you select to call with mobile your mobile phone will ring, pick up the call and the mobile
phone will automatically connect to the called party. You can see the call setup progress in
the calls view in Telia Touchpoint Flex Softphone.

If enabled, you can also control the remote call from the softphone by calling using the Call
Control feature. See Section 3.16, “Remote call control for calls with another phone” for more
information.

You can see whether you have call with or call control capabilities in the bottom left corner
device picker. If the title says "Call With" you have call with capabilities and if the title is "Call
Control" then you will also be able to control the calls using Telia Touchpoint Flex Softphone.

3.3.5. Callto and Tel URL calls
A callto link or an Tel URL on a web page is a phone number as a link. Callto links and Tel
URLs are supported with Telia Touchpoint Flex Softphone. Click a number with a callto or tel
link and Telia Touchpoint Flex Softphone will automatically call the number and connect you.

Note

Click the Handle callto button to set up the callto: links in the Advanced set-
tings. This will open the Default Programs in the Control panel in Windows.
Choose the Telia Touchpoint Flex Softphone, then select "Set this program as
default". This will configure the application to call numbers when clicking on call-
to: and tel: links.

Note

If you have Skype installed, it will try to override your callto setting and handle the
call with Skype instead of with Telia Touchpoint Flex Softphone. Make sure to
start Telia Touchpoint Flex Softphone after Skype is started to solve this problem.

3.4. Receiving A Call

When a call is received, click Answer Call  to pick up the call.

You can also answer the call from the icon in the taskbar. Right-click the icon and select
Answer Call.

You can mute the ring signal of an incoming call.

Click Mute Ringer  to mute the ringer.

3.5. Hanging Up or Rejecting a Call

Click Hangup Call  to end or reject a call.

You can also reject, or hang up the call from the icon in the taskbar. Right-click the icon and
select Reject or Hangup.

3.6. Holding a Call
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It is possible to hold ongoing calls.

1.
Click Hold  or place a new call using the main window. Placing a new call will auto-
matically put the ongoing call on hold.

The held party will hear music on hold, spoken hold information in your locale, or another
prompt depending on configuration in the system.

2.
Click Resume  to resume a call. If another call is active, clicking Resume will auto-
matically put the active call on hold.

3.7. Parking a Call
It is possible to park calls in the personal queue.

1.
Click Park  . The call will be parked in queue. If allowed, other users can also pick
up the parked call.

2.
Click Call Pickup  to pickup the call.

3.8. Transfer a Call

3.8.1. Blind Transfer
Blind transfer allows the calling party to be transferred to another party. When a call is blind
transferred, the remote party will be transferred directly. If the transfer fails because of no
answer or a busy line the transferred party can connect with the party that transferred the
call again.

Note

During a transfer, new incoming calls will be placed in your personal queue, if no
other call routing rules apply. You can pick up a new call in the queue by clicking
on the pick up button.

To make a blind transfer

1.
Click Call Transfer  and search or dial the contact to transfer the call to.

2.
Click Transfer  for the contact to transfer the call to.

To make a blind transfer, bypassing any diversion rules

Note

Transfer with diversion bypass may not be available for all users. The service is
only available to users that are authorized to do so.

1. Click Transfer Options  , select the Bypass Diversion Rules menu item, and search or
dial the contact to transfer the call to.
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2.
Click Transfer  for the contact to transfer the call to.

To make a blind transfer to a contacts voicemail

Note

Transfer to voicemail may not be available for all users. The service is only avail-
able to users that are authorized to do so.

1.
Click Call Transfer  and search or dial the contact to transfer the call to.

2.
Click Transfer  for the contact to transfer the call to then select Transfer to voicemail
as the number to transfer to.

3.8.2. Attended transfer
Attended transfer makes it possible to transfer a call, while first getting the option to talk to the
party where the call is being transferred. If the called party accepts the transfer, the remote
party will be connected with the new party and it is possible to leave the call.

1. During a connected call, place another call. The connected call will be placed on hold.
Wait for the calling party to answer.

2.
Switch back to the first call and click Call Transfer  to start transferring the call. Click

Transfer  to the called party.

It is also possible to drag and drop a call to another in the call panel.

3.8.3. Camp-On
Camp-On is an Attendant functionality which allows you to transfer a call to a busy user. If
the user is busy with a call, a personal queue is created, which the transferred call is put
on hold in. When the user's first call is ended, the transferred call in the personal queue is
connected. See Section 9.7, “Camp-On” for more information.

3.8.4. Failed transfer
Whenever a transfer or camp-on has failed, you will get notified and can pick up the call
again. This could be, for example, if the contact you transferred the call declined to answer.
The call will be placed on hold, and the call will flash in the call view of your application to
let you know this call requires immediate attention.

3.9. Move to Client
It is possible to move an ongoing call in the application to another client, for example a mobile
phone or a desktop phone.

To move a call to another client

1. Select a device from the Move this call to list.
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2.
Click Move call .

3.10. Sending DTMF tones
If you call a voice mail or any other interactive voice response service where telephone tone
dialing (DTMF tones) is required, it is possible to open a keypad from the active call panel.
You can also use the numeric keypad on your keyboard to send the tones.

Click Open Keypad  in the active call panel to open the keypad and click the numbers
to send. It is also possible to use the numeric keypad on your keyboard to send the tones.

3.11. Recording a Call

During a call, it is possible to save the conversation to a file. Press Record  to start the

recording. Press Stop  to end the recording.

Click the Inbox, go to the Log or select Tools > Inbox to listen to a recorded call. See Sec-
tion 8.2, “Checking messages”.

3.12. Conference Calls

3.12.1. Creating a Conference Call
The following steps describe how to set up a local conference call:

To set up a conference call

1. Receive or place a call.

2.
When the call is connected, click  .

The Conference call panel is opened, containing the active call. Additional calls can now
be added to the conference.

3. Place another call. The active call will be placed on hold.

4. When the new call is connected, click Add to Conference to add the call to the conference.

5. Repeat placing new calls and add to the conference to add more participants.

Note

The amount of licences for conferences in the system puts an upper limit on
the number of participants that can be added to a conference.

3.12.2. Disconnecting Participants
The Conference Call panel displays all connected participants in the conference. Click for a
selected participant to disconnect or to put a participant on hold.

3.12.3. Ending a conference Call
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A conference call is ended when the conference organizer disconnects the call, or when all
participants has been removed from the conference call. Click Hangup to terminate the con-
ference call. The conference organizer will have the option to allow the rest of the participants
to continue conferencing when disconnecting. Allowing this will move all other participants
to the conference server.

3.13. Log
The log shows placed, received, missed calls, voicemail, recordings and fax messages. The
time and duration of the events are also shown. It is possible to place new calls using the

call data information from the log. Click  for a call in the log to place a new call.

You can sort the log by all calls, missed calls and inbox items. Click on the sort button for
your preferred filter.

• All - Show all calls.

• Missed calls - Show only missed calls.

• Inbox - Show only inbox items.

You can delete all log items shown in your filter. Choose the filter that shows the items you
want to delete, and click the bin icon.

You can also delete single log items. Click on an item to expand it and click the bin icon on
that item to delete.

To listen to a voicemail or call recording

• Click  to download the item. It will start automatically to play the voicemail or call recording

when the download is finished. You can pause the playback by clicking 

To see a fax message

• Click  to download the fax message. The fax message is in pdf format and your preferred
pdf reader will be opened automatically to show the message.

3.14. Calling from Microsoft Office Applica-
tions

It is possible to click to dial from Microsoft Office applications such as Word, Excel, and Pow-
erPoint. The application installs an add in that is loaded by Microsoft Office. The application
must be installed on the computer before the add in can be seen in Microsoft Office. The
OutlookAddin.dll file is installed with the application. The add in will appear as a toolbar in
Microsoft Outlook.

Note

Call <select a contact> and Call with mobile must be visible on the toolbar in
Microsoft Outlook. To activate the Call <select a contact> press the Contacts
button.
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Note

The only difference between using the Telia Touchpoint Flex Softphone add-in
in Microsoft Office 2003 and 2007/2010 is:

• In Microsoft Office 2003 the add-in will appear on the toolbar.

• In Microsoft Office 2007/2010 the add-in will appear under the Add-Ins ribbon.

To make a call using Microsoft Outlook 2003, 2007 and 2010:

1. Start the Telia Touchpoint Flex Softphone and check that it is running.

2. In the left navigation pane, select the  Contacts  button. The contact numbers can be
seen in different views.

3. In the menu bar, select  Call (select a contact)  .

4. Select the phone number to call from the call button drop down menu. The application
should appear and start to call the phone number that was selected.

Note

If the button is grayed out, the application is not running. To activate it either
start the application and click on the  Contacts  button in Microsoft Outlook.

To select different options:

1. Start the Telia Touchpoint Flex Softphone and check that it is running.

2. In the left navigation pane, select the  Contacts  button.

3. Select the device that will used for subsequent calls In the drop down menu next to the call
<name of contact> there is a button called call with..., select one of the following options:

Note

The calling options depend on how the server has been configured. To adjust
these options contact the server Administrator.

• Call with Mobile

• Call with SIP desktop phone

• Call with Telia Touchpoint Flex Softphone

To call using the smart tag in a Microsoft Office application:

1. Enter the phone number in the correct format into the selected Microsoft application.

2. Click on the i icon and select the Smart tag Options in the drop down menu.

• Call: (phone number)

• (Product name)

• Remove this Smart Tag

• Stop recognizing "(phone number)"

• Smart Tag Options...
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3. Place your cursor over the phone number until the i icon appears and in the drop down
menu select the option.

4. The Telia Touchpoint Flex Softphone should appear and automatically dial the phone
number.

A few examples of accepted phone number formats:

Note

If the i icon does not appear when the cursor is placed over a phone number
then the phone number format is not acceptable.

• 08-7687230

• 202 121 2222

If the smart tag option is selected in the drop down menu:

1. Under the tab Smart Tags, check the check box label data with smart tags.

2. Under recognizers check the check boxes that apply (this will differ in Word, Excel and
PowerPoint).

To search for a contact in Outlook from the contact list in the Telia
Touchpoint Flex Softphone:

1. A user can search for a contact in Microsoft Outlook by going to the Telia Touchpoint
Flex Softphone and entering the name of the contact that is being searched for in the dial
number field.

2. Enter the first letter of the contacts name of the full name of the contact and hit return. The
contact will appear under the Outlook Search Result List. Telia Touchpoint Flex Softphone
can pick up contacts from Outlooks contact list.

3.14.1.  Setting up the Telia Touchpoint Flex Softphone
in Microsoft Word, Powerpoint or Excel

To activate the smart tag option in a Microsoft application:

1. Go to the Microsoft Office icon in the upper left hand corner of your application and click
Office

2. Click  Word/Powerpoint/Excel Options

3. In the left navigation bar, select Proofing.

4. In the AutoCorrect window, click on the  AutoCorrect Options

5. Mark the checkbox Label text with smart tags.

6. Mark the checkbox Call (Softphone+ telephone number smart tag recognizer).

7. Click OK in the AutoCorrect window.

8. Click OK in the Word/Powerpoint/Excel Options window.

To re-enable the softphone add-in:

1. Go to the Tools menu in Microsoft Outlook and select  Trust Center  .
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2. In the Trust Center window under the menu on the left, select Add-ins.

3. In the main window look for the application Add-in. If it does not appear in the list then go to
the bottom of the list and under Manage in the drop down menu, select  Disabled Items  .

4. Press the Go... button.

5. Select the add-ins that will be enabled and click on the  Enable  button.

Note

Outlook might have to be restarted in order for these changes to take place.

3.15. Volume control
You can control the volume for a call and switch between headset mode and speaker mode
from the bottom area of the softphone. You can also mute your microphone by clicking on

You can also mute the microphone from the dock icon. Right-click the dock icon and select
Mute. To unmute, select Unmute.

3.16. Remote call control for calls with anoth-
er phone

You can call with another mobile or deskphone, but control the call using Telia Touchpoint
Flex Softphone. You initiate the call using Telia Touchpoint Flex Softphone and can control
transfers, park/pickups etc. using the UI of the desktop app. After initiating the call on the
softphone you need to answer it manually on the device that you want to control. The remote
call control feature needs to be enabled by your service provider.

To choose which device to call with or control, click the device icon in the bottom left of your
app window. You can see whether you have call with or call control capabilities in the bottom
left corner device picker. If the title says "Call With" you have call with capabilities and if the
title is "Call Control" then you will also be able to control the calls using Telia Touchpoint
Flex Softphone.

Figure 3.3. Remote call control setting

If you call using call with, the call will be initiated as a call-back call and you will have full
functionality on the call on the device, but no call control from Telia Touchpoint Flex Soft-
phone. If you call using call control, the call will also be initiated as a call-back call and you will
have call control from the Telia Touchpoint Flex Softphone. However, some limitations are
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on the capabilities of the call compared to when calling using call with, see Section 3.16.1,
“Supported features and limitations”.

To place a call with remote call control:

1.
Click 

2. Select the device that you want to call from.

3. Search for a contact, or enter a phone number and place the call as you would normally do.

The server will initiate a call-back call to your selected device.

4. Answer the call on your selected device.

5. The calls view will open up in Telia Touchpoint Flex Softphone and you can control the
call from there.

3.16.1. Supported features and limitations
The following features can be performed on a remotely controlled call:

Supported features

• Transfer call

• Park/pickup call

• Hold/resume call

Limitations

• Multiple outbound calls at the same time is not supported

• Calls cannot be parked by remote participant

• Calls cannot be parked if calling to external participant
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Chapter 4. Contacts
The Contact list show all your contacts together with presence information. Clicking on a
name of a contact will give you more information about the contact.

Your Favourite list is displayed by default and you can search for other directory contacts
by start entering their names.

To search for a contact

• Start entering characters. The contact list is updated automatically based on your input.

You can search for contacts by first name, last name, department, any of the custom fields,
or a combination. For example, if you want to search for John in Sales, you can enter “Joh
Sal” and all contacts that match will appear, including John in the Sales department.

Selecting a contact will open up the detailed view of the contact.

4.1. Favourites, VIPs and Blocked contacts
Your contacts are either normal contacts or one of the following:

• Favourite - a contact that is displayed in your Contacts list when you don't have an active
search query

• VIP - a contact, also added to Favourites, that you can add specific call routing rules for.
Rules set both for VIP and Favourites will apply to VIP contacts.

• Blocked - a contact that you can add specific call routing rules for

4.2. Adding contacts
Contacts can be added using the application or the user web.

To add a local contact

1. Click Add Contact  in the toolbar.

2. Enter the contact details and add a phone number. It is possible to add more than one
phone number for a contact.

3. Click Apply to save the contact information. The contact is added to your contact list.

4. Select if the contact should be added as a Contact, Favourite, VIP or Blocked Contact.
You can then set call routing rules depending of the type of contact.

4.3. Removing contacts
Your Favourites list is the default view in Contacts. You can add or remove contacts from
the favourites list by clicking on the star/unstar icon for the contact. You can add and remove
local contacts to your favourites list. If you want to delete a local contact permanently you
can click on the trash bin icon. You can only delete local contacts.

To remove a contact from Favourites

•
Click the name of a contact in the Contacts list and then Unstar .
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To delete a local contact

•
Click the name of a contact in the Contacts list and then Remove this contact .

4.4. Edit contacts
You can edit the contact information for contacts you have created. You cannot edit the
contact information for contacts within your organization.

To edit a contact

•
Click the name of a contact in Contacts and then Edit this contact .

4.5. Exchange calendar
If you are authorized, you can see the Exchange calendar status for your contacts in the
contact details. A blue icon will be shown if the user will be busy with a meeting in the next
60 minutes, and a red icon will be displayed if the Exchange calendar shows that the user
is busy.

If you are authorized, and the calendar is shared by the user to you, you can also see the
user's calendar agenda for the current day.



Chapter 5. Chat, Collaboration
and Messaging

Revision: 4.7.15.46 21

Chapter 5. Chat, Collaboration and
Messaging

5.1. Chat
Note

All users can chat with online users from Contacts. The full collaboration feature
with extended chat functionality is available for Collaboration enabled users only.

Instant messages (IMs) are routed to all your available devices for the first message in a
chat session. Subsequent messages are routed only to the device on which you reply. For
example, if you have an application on your laptop and your mobile phone and receive an IM
from user A, both the applications on your laptop and your mobile phone receive the IM. If
you reply on your mobile, all future IMs within this chat session with user A will be delivered
only to the mobile, and not to the laptop. In addition, all your IMs are only delivered to the
device from which user A sent the IMs. However, if you or user A close the conversation
window, the chat session ends and any new IM will be routed to all your devices.

You can open a chat window and send IMs to online contacts within your organization. The
chat window is divided into three parts: contact details at the top, chat history in the middle
and the text input field at the bottom of the window.

To start a chat from the Contacts tab:

1.
Go to Contacts, select a contact and click Start chat  to open a chat window.

2. Enter text in the chat window and press the Return key or click Send to send the message.

With the Collaboration feature enabled, you will obtain a set of features for advanced collab-
oration. It will provide maintained chat history in all devices as well as other tools to improve
team work. See further in the section "Collaboration" below.

5.2. Collaboration
Collaboration includes more advanced features like:

• Chat - where all messages are shown. New messages, file uploads etc. are shown here.

• Pages - where pictures, illustrations and other file uploads are stored.

• To-Do - add To-Do lists to share among the members of the chat group.

• Meet - Start ad hoc meetings with the group members.

With the Collaboration feature enabled, you can use the advanced chat feature. You can
have an individual chat (with one other user) or a group chat with multiple participants. If
MiTeam collaboration is enabled for your organization, you will have access to even more
features under the MiTeam tab. For more information, refer to the chapter, "MiTeam: Streams
and Meets."

5.2.1. Advanced chat
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An advanced chat can be started as an individual chat or a group chat.

5.2.1.1. Individual chat

An individual chat is started in the Contacts view. Whenever the other user has Collaboration
capabilities, a new collaboration chat will start. If the other user does not have Collaboration
capabilities, a basic chat will start. If a Collaboration session with the other user already
exists, it will be continued in the same. Otherwise a new chat session is created.

5.2.1.2. Group chat

An group chat is always started from the Chat tab.

To start a group chat:

1. Navigate to the Chat tab.

2. Click the New button.

3. Enter a title for the chat.

4. Select participants. (Start by typing a participant's name in the search field, and then select
the desired contact from the filtered list of matches that is displayed.)

5. Click Create to invite participants and start the chat.

6. Enter your chat message in the Send message field at the bottom of the Chat pane, and
press Enter.

Note

You can insert a new line within your message by pressing Shift+Enter.

5.2.1.3. Chat options

The following options are available from the Chat pane:

• Send message - Type a message in the Send message field, and press Enter.

• Invite member - Click the Options icon in the upper-right of the Chat pane, and then click
Invite Member. Select the participants to add to the chat and then click Update.

• Modify chat settings - Click the Options icon in the upper-right of the Chat pane, and then
click Settings. The following chat settings are available:

• Name - specify a name for the chat

• Cover Image - upload a custom cover image for the chat

• Push Notification - select whether to activate push notifications for the chat

• Send Messages Silently - send chat messages without an audible notification

• Leave or Delete - leave or delete the chat

• Add file - Click the Add file (+) icon in the lower-right of the Chat pane, and select the
type of file to add to the chat. (For more information on this feature, refer to the section
"Adding files".)

5.2.1.4. Adding files
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You can upload files to your chat to share them with members of the chat group. Further
options are available for annotating and collaborating with the uploaded files. The following
types of files can be added to a chat:

• Desktop - a file from your desktop or any folder on your computer

• Chats/Streams - the contents of another chat or Stream

• Whiteboard - creates a virtual whiteboard within the chat

• Note - activates a text editor where a note can be created within the chat

All members of the chat group can annotate, comment on or modify the files that are added
to a chat. Once a file is added, it is also organized under the Pages area for the Collaboration
session. Available actions depend on the type of file, but include:

• Annotate and comment

• Create clip

• Download or copy to another chat

• Create To-Do item

• Share

• Undo changes

• Rename or delete file

• View thumbnail images

• Zoom in or out, view in fullscreen mode (Not valid for whiteboard).

5.2.2. Pages
You can use the Pages area to create, add or upload files to a chat or Stream. You and
members of your chat group can also create and share annotations on uploaded files, pro-
viding you with the ability to collaborate on the content stored within the chat.

Any files that have been uploaded or created within a chat or Stream will be stored in the
Pages area. You can also drag and drop files directly to the Pages area, and create folders to
organize your uploaded content. For example, you may want to keep images and documents
in separate folders, or organize content about a particular topic.

To add a file:

• Drag and drop the desired file directly to the Pages area, OR

• Click the Add file (+) icon in the lower-right corner of the Pages area, and select the type
of item to add (Desktop, Chats/Streams, Whiteboard or Note).

All members of the chat group can annotate, comment on or modify the files that are added
to the Pages area.

To add a folder:

1. Click New folder.

2. Type a name for the folder, and click Create.
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Files within the chat or Stream can be moved to the folder.

To move a file:

1. From within the Pages area, click the Info icon on the lower-right corner of the thumbnail
image for the file.

2. Select Move to, and then select the chat or Stream to which you want to move the file.

Hint: if a chat or Stream has folders, an arrow icon will appear next to the name of the
Stream or chat. If desired, click the arrow and select the folder to which you want to move
the file.

3. Click Move.

5.2.3. To-Do
You can use the To-Do feature to create, organize and assign tasks among members of a
chat group. Your team’s tasks are kept in one place, so that everything is actionable and
transparent.

To create a To-Do list:

1. Select the chat for which you want to create a to-do list, and click To-Do.

2. In the Add a To-Do item field, type the text for your first To-Do item, and click Enter.
The item now appears in your To-Do list, and is available for editing by any member of
your chat group.

3. Enter additional items as needed.

The following actions are available from within the To-Do list, for any member of the chat
group:

• Search - In the Search To-Do field, you can enter a search string. This filters the list to
show only items containing the text that you enter.

• Sort - By default, the list shows all To-Dos. You can select the dropdown to view all To-
Dos, items that are assigned to you, items that are unassigned, or items that are assigned
to a specific member of the chat group.

• Mark an item as completed - Click the checkbox beside the list item.

• Flag the item as important - click the flag icon beside the list item. Items flagged as impor-
tant will appear at the top of the list.

If you click on an individual list item, the following actions are also possible:

• Assign an item to a member of the chat group - Click Assign to, and select the member
to whom the item should be assigned.

• Set a due date for the item - Click Set due date. From the calendar pop-up, select the date
and time by which the item must be completed.

• Set a reminder - Click Remind me. From the calendar pop-up, select the date and time
you want to be reminded.

• Add an attachment - Click Add attachment, and navigate to select the item you want to
add. (You can add content from a Chat or Stream or a file from your computer.)
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• Copy or move the item to another list - Click Copy/Move, and then select Copy To or
Move To. You now have the following options:

• Select the chat or Stream to which you would like to copy or move the item, OR

• Click Start a new conversation to create a new conversation with the copied or moved
item.

• Delete an item - Click Delete.

• Add a description - In the Add description field, enter a description of the To-Do item.

• Add a comment - In the Add a comment field, enter a comment about the To-Do item.

• Mark an item as completed - Click the checkbox next to the name of the To-Do item.

• Flag an item as important - Click the flag next to the name of the To-Do item.

To return to the list view, click the right-arrow icon to close the detailed actions pane.

5.2.4. Meet
From within an existing chat, you can use the Meet feature to start an ad hoc, online meeting
with members of a chat group. A Meet is a real time collaboration tool, with or without voice
and video, with the possibility to do screen and file sharing.

Note

Voice communication is handled separated from the video stream and the voice
icon within the video share is disabled.

To start a one-to-one ad hoc Meet inside a chat:

1. Select the chat from which you want to start the meeting, click Meet and then click Meet
Now/guilabel>.

2. Select the type of meeting you want to initiate:

• Voice call - initiates a voice call in the Softphone application.

• Web meet - initiates a collaboration session in your default Web browser, with video
capability as well as the ability for file and screen sharing.

• Voice + web - initiates a collaboration session with an instant voice bridge.

To start an ad hoc Meet with team members inside a chat:

1. Select the chat from which you want to start the meeting, click Meet and then click Meet
Now.

2. Select your preferred way to start the ad hoc meet:

• Dial in - initiates a voice call in the Softphone application.

• Open web - initiates a collaboration session in your default Web browser, with video
capability as well as the ability for file and screen sharing.

• Dial in + open web - initiates a collaboration session with an instant voice bridge.

Participants may leave the Meet while it is still ongoing but the Meet invitation will remain
until the initiator has ended the Meet.
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To join an ad hoc Voice meeting:

• Answer the voice call in your Softphone application (one-to-one conference), OR

• Click the handset icon to connect with the voice bridge (multiple participants).

To join a Web or Voice+Web meeting:

1. If the meeting is a Voice+Web meeting, click the handset icon to connect with the voice
bridge.

2. From the invitation in your chat list, click Join.

Note

When you join a Web meet for the first time, you may be prompted to install
a plugin for your Web browser. Depending on your browser, the plugin may
be downloaded automatically or you may be directed to an online store to
download the plugin.

5.3. Messaging

5.3.1. SMS messages
You can send SMS messages to contacts and phone numbers with the application. You can
send SMS message to one or many contacts.

You can also change the from number of the SMS message to a function number or ACD
number, if you are authorized. This could be used if, for example, you want to send an SMS
message from the ACD group instead of your own personal phone number.

To send an SMS message to a contact:

1.
Select a contact and click Send SMS .

2. Choose the number to which you want to send the SMS message, if there is more than
one number to choose from.

3. Choose the number from which you want to send the SMS message, if there is more than
one number to choose from.

4. Enter your message and click Send.

To send an SMS message to a group:

1. From the toolbar, select Services > Send message to listed contacts, then select SMS.

The contacts in your current search with a mobile phone will be added to your messaging
screen.

2. Choose the number on the contacts to which to send the message to by clicking on the
dropdown list. You can remove any contacts you do not want to send the message to by
clicking x next to the contact.

3. Enter your message and click Send.

5.3.2. Email messages
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The first time you use this service you will set whether you are using Microsoft Outlook or
another email application. This is to configure whether to use semi-colon or comma to sep-
arate the addresses.

To send an email message to a group:

1. From the toolbar, select Services > Send message to listed contacts, then select email.

The contacts in your current search with an email address will be added to the To: field
in your default mail application.

2. Enter your message and send it using the usual procedure in your email application.
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Chapter 6. MiTeam: Streams and
Meets

From the MiTeam view, you can create collaboration sessions with your team members, in-
cluding participants from outside your organization. These sessions - called Streams - pro-
vide advanced tools for team interaction as well as the ability to schedule Meets. A Meet is
a conference that can be Voice only, Web only or Voice and Web.

In the MiTeam view you can create new Streams as well as Meets. Streams are intended for
long-term collaboration, as opposed to Chat sessions, which are more ad hoc oriented. The
MiTeam view lists your current Streams and Meets. This includes Streams and Meets you
have created yourself, accepted to be a participant in or that you are invited to join. A Meet
that is about to start within 10 minutes will appear at the top of the list.

6.1. Streams
To create a new Stream:

1. Click the Plus sign icon on the left side menu.

2. Click Create a stream.

3. Enter a title for the Stream.

4. Search and select contacts by typing the name in the search field to get auto-fill options.

To invite external participants, enter e-mail address, or phone number.

5. Click Create.

The other participants are automatically invited to your Stream.

From within a Stream, you have access to the following collaboration features:

• Chat - where all messages are shown. New messages, file uploads etc. are shown here.

• Pages - where pictures, illustrations and other file uploads are stored.

• To-Do - add To-Do lists to share among the Stream participants.

• Meet - Start ad hoc meetings or schedule meetings with the Stream participants.

6.1.1. Stream options
The following options are available from the Stream pane:

• Send message - Type a message in the Send message field, and press Enter.

• Invite member - Click the Options icon in the upper-right of the Stream pane, and then
click Invite Member. Select the participants to add to the Stream and then click Update.
Participants can be added as editors (with the ability to collaborate) or viewers (read-only).

• Modify Stream settings - Click the Options icon in the upper-right of the Stream pane, and
then click Settings. The following settings are available:

• Name - specify a name for the Stream
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• Cover Image - upload a custom cover image for the Stream

• Category - enter a category for the Stream

• Push Notification - select whether to activate push notifications for the Stream

• Send Messages Silently - send messages without an audible notification

• Download - Download a screenshot from the Stream

• Leave or Delete - leave or delete the Stream

• Add file - Click the Add file (+) icon in the lower-right of the MiTeam pane, and select the
type of file to add to the Stream. (For more information on this feature, refer to the section
"Adding files".)

6.1.2. Chat

To start a chat within your Stream:

1. Navigate to the Chat pane.

2. Type your message in the Send message field at the bottom of the pane.

6.1.3. Adding files
You can upload files to your Stream to share them with members of the Stream group. Further
options are available for annotating and collaborating with the uploaded files. The following
types of files can be added to a Stream:

• Desktop - a file from your desktop or any folder on your computer

• Chats/Streams - the contents of another chat or Stream

• Whiteboard - creates a virtual whiteboard within the Stream

• Note - activates a text editor where a note can be created within the Stream

All members of the Stream group can annotate, comment on or modify the files that are
added to a Stream. Once a file is added, it is also organized under the Pages area for the
Stream. Available actions depend on the type of file, but include:

• Annotate and comment

• Create clip

• Download or copy to another chat

• Create To-Do item

• Share

• Undo changes

• Rename or delete file

• View thumbnail images

• Zoom in or out, view in fullscreen mode
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6.1.4. Pages
You can use the Pages area to create, add or upload files to a Stream. You and members of
your Stream group can also create and share annotations on uploaded files, providing you
with the ability to collaborate on the content stored within the Stream.

Any files that have been uploaded or created within a Stream will be stored in the Pages
area. You can also drag and drop files directly to the Pages area, and create folders to
organize your uploaded content. For example, you may want to keep images and documents
in separate folders, or organize content about a particular topic.

To add a file:

• Drag and drop the desired file directly to the Pages area, OR

• Click the Add file (+) icon in the lower-right corner of the Pages area, and select the type
of item to add (Desktop, Chats/Streams, Whiteboard or Note).

All participants with Editor access to the stream can annotate, comment on or modify the
files that are added to the Pages area.

To add a folder:

1. Click New folder.

2. Type a name for the folder, and click Create.

Files within the Stream can be moved to the folder.

To move a file:

1. From within the Pages area, click the Info icon on the lower-right corner of the thumbnail
image for the file.

2. Select Move to, and then select the chat or Stream to which you want to move the file.

Hint: if a chat or Stream has folders, an arrow icon will appear next to the name of the
Stream or chat. If desired, click the arrow and select the folder to which you want to move
the file.

3. Click Move.

6.1.5. To-Do
You can use the To-Do feature to create, organize and assign tasks among participants
in a Stream. Your team’s tasks are kept in one place, so that everything is actionable and
transparent.

To create a To-Do list:

1. Select the Stream for which you want to create a to-do list, and click To-Do.

2. In the Add a To-Do item field, type the text for your first To-Do item, and click Enter.
The item now appears in your To-Do list, and is available for editing by any participant
in the Stream.

3. Enter additional items as needed.

The following actions are available from within the To-Do list, for any participant in the Stream:
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• Search - In the Search To-Do field, you can enter a search string. This filters the list to
show only items containing the text that you enter.

• Sort - By default, the list shows all To-Dos. You can select the dropdown to view all To-
Dos, items that are assigned to you, items that are unassigned, or items that are assigned
to a specific participant.

• Mark an item as completed - Click the checkbox beside the list item.

• Flag the item as important - click the flag icon beside the list item. Items flagged as impor-
tant will appear at the top of the list.

If you click on an individual list item, the following actions are also possible:

• Assign an item to a participant - Click Assign to, and select the participant to whom the
item should be assigned.

• Set a due date for the item - Click Set due date. From the calendar pop-up, select the date
and time by which the item must be completed.

• Set a reminder - Click Remind me. From the calendar pop-up, select the date and time
you want to be reminded.

• Add an attachment - Click Add attachment, and navigate to select the item you want to
add. (You can add content from a Chat or Stream or a file from your computer.)

• Copy or move the item to another list - Click Copy/Move, and then select Copy To or
Move To. You now have the following options:

• Select the chat or Stream to which you would like to copy or move the item, OR

• Click Start a new conversation to create a new conversation with the copied or moved
item.

• Delete an item - Click Delete.

• Add a description - In the Add description field, enter a description of the To-Do item.

• Add a comment - In the Add a comment field, enter a comment about the To-Do item.

• Mark an item as completed - Click the checkbox next to the name of the To-Do item.

• Flag an item as important - Click the flag next to the name of the To-Do item.

To return to the list view, click the right-arrow icon to close the detailed actions pane.

6.2. Meets
From the MiTeam tab, a Meet can be initiated either as ad hoc or scheduled. It is also possible
to include participants from outside your organization.

To start an ad hoc Meet with team members inside a stream:

1. Select the stream from which you want to start the meeting, click Meet and then click
Meet Now.

2. Select your preferred way to start the ad hoc meet:

• Dial in - initiates a voice call in the Softphone application.

• Open web - initiates a collaboration session in your default Web browser, with video
capability as well as the ability for file and screen sharing.
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• Dial in + open web - initiates a collaboration session with an instant voice bridge.

You can invite guests to join a scheduled Meet using their email address. Guests can be both
internal users within your organization without the Collaboration license and external users
outside your organization. Guests will be able to access the Meet in a Web browser.

Schedule a Meet inside a Stream:

1. Click the Plus sign icon on the left side menu.

2. Click Schedule a meet.

3. In the Scheduler dialog:

• Insert Title.

• Set the start Date, or click Now.

• Set Duration.

• Set Repeat sequence if applicable.

• Select Timezone.

• Link with stream. Start typing to get auto-fill options.

• Search and select contacts by typing the name in the search field to get auto-fill options.

To invite external participants, enter e-mail address, or phone number.

• Write an invitation Note. The text will be displayed in the invitation email and calendar
event.

• Set the preferred meeting reminder time to the calendar invitation.

• Set the preferred time for SMS text message reminder.

• Click Schedule.

The details of your Meet, including dial-in numbers, are displayed.

To create a scheduled Meet outside a Stream:

1. Click the Calendar icon at the top-left of the Stream pane.

2. Select Create a Meet.

3. In the Scheduler dialog:

• Select the start and end date and time plus time zone.

• Set recurrence (Repeat) when applicable.

• Search and select contacts by typing the name in the search field to get auto-fill options.

To invite external participants, enter e-mail address, or phone number.

• Write an invitation note. The text will be displayed in the invitation email and calendar
event.

• Set the preferred meeting reminder time to the calendar invitation.
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• Set the preferred time for SMS text message reminder.

• Click Create.

The details of your Meet, including dial-in numbers, are displayed in the Streams list.

To join a scheduled Meet (internal users):

1. In the MiTeam list view, click the Info icon next to the name of the Stream. A list of sched-
uled Meets for the Stream is displayed.

2. Click handset icon in the Meet item to join the voice conference.

3. The invitation to the Web Meet is displayed. To join, click the Web Meet (globe) icon.

To join a scheduled Meet as a guest:

1. Call the Meeting number provided in the meeting invitation and enter the meeting ID num-
ber when prompted.

2. Follow the link provided in the meeting invitation to join the Web meeting.

Note

If you join a Web meeting as a guest, the session expires after 8 hours. To rejoin
the Web meeting, return to the meeting invitation and click the link again.

To delete a scheduled Meet:

• If the Meet is about to start within 10 minutes, select it in the Stream time line and then
click Delete in the details view.

• If it occurs later:

1. Click the Calendar icon, then select View all meets.

2. Click the Info icon for the desired meeting.

3. Click Delete.

To edit a scheduled Meet:

• If the Meet is about to start within 10 minutes, select it in the Stream time line and then
click Edit.

• If it occurs later:

1. Click the Calendar icon, then select View all meets.

2. Click the Info icon for the desired meeting.

3. Click Edit.

• Change the details as required and click Update.

To leave a Stream:

1. Click the Info icon and then click Leave stream.

2. Confirm leaving the Stream.
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Note

Only participants (not owner) of a Stream have the option to leave.

When leaving a Stream, all Meets scheduled by the participant in the Stream
will also be cancelled.

To remove (delete) a Stream:

1. Click the Info icon and then click Delete stream.

2. Confirm removal of the Stream.

Note

A Stream can only be removed by the owner (the user who created it).

When removing a Stream, all Meets scheduled by the owner will also be can-
celled.
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Chapter 7. Settings
7.1. Presence

As a user in the system, you can select between different activities and roles available in the
system. For example, if you want to have your calls routed to a specific phone when you are
out of office, it is possible to set a specific role and activity matching the case. Activities and
Roles are defined and configured by the system administrator.

7.1.1. Activities

The presence state for an Activity can either be Available  or Unavailable  .

Depending on system settings, certain users or user groups may not be able to see the
presence state for all other users or user groups.

To set an activity:

• Click on the Activity text and select a new activity from the drop down list or select Set
activity and end time.

The following default activity types are available:

• Available

• Busy

• Lunch

• Meeting

• Out of office

• Vacation

How incoming calls are routed depending on your activity can either be defined by your
system administrator or if you are an authorized user you can manage your own settings.
See Section 8.4, “Configuring Call Routing”

7.1.1.1. Presence shortcut

You can configure your own presence shortcuts. The created presence shortcuts will be
synchronised to all your devices. The presence shortcut is a quick way to set your presence
with an end time.

To add a new or edit a shortcut

1. Click your activity

2. Click Edit shortcuts...

3. Click + to add a new or click a current one to edit it

4. Edit the shortcut with the following fields:

• Name - Name of your shortcut

• Activity - Your activity
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• Availability - If your state should be available (green) or Do not disturb (red)

• Duration - Your end time. This can be either no end time, until next workday (calculated
based on your working hours) or a set time period from 15 minutes to 1 day. The time
is approximate and will adjust to closest 5 min - hour based on duration length.

• Activity diversion - If you should override any diversion state. There are a few options:

• Use default diversion - The active diversion will be the one mapped to the activity
if such mapping exist, or another previously set diversion. Active diversion will be
the activity diversion or previously set diversion if one of them is set, otherwise no
diversion.

• Clear default diversion - The will clear any previous set diversion. Active diversion
will be no diversion.

• Override default diversion - The active diversion will be the number set in the Di-
version number field.

• Diversion number - Set the number to divert to. If this is empty and Activity diversion is
marked any previous set diversion will be overridden and set to no diversion.

• Icon - Choose an icon. It will only be visible to you.

Note

If you have greyed out shortcuts this means that the activity mapped to the short-
cut no longer exists on the system. Edit the shortcut and choose a valid activity.

7.1.1.2. Custom Activity

A custom activity will let you set a new active activity, availability, end time and activity di-
version.

See Presence shortcuts for information on the different options.

7.1.1.3. Future presence

You can schedule future presence events. See Section 8.5, “Future presence” for more in-
formation.

7.1.1.4. Activity diversion

You can configure activity diversions that will automatically divert calls to your number based
on your activity.

Note

You need to have a call routing rule that direct received calls to active diversion
number to make any diversion happen.

To add an activity diversion

• Click on +

• Select your activity

• Set a number to divert to

• Click Save
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7.2. Personal Note
It is possible to edit a personal note that will be visible to other users within the organization.
Click the Note text in the live aid area to change your personal note.

7.3. Changing another user's presence infor-
mation

You can change the presence information regarding activity, role, future presence and
change the personal note if you have the authorization for it.

To change another user's Activity

1. Select the user.

2. Click on the Activity message.

3. Select the new activity, or select Set activity and end time to set an end time to the
activity.

To change another user's role

1. Select the user.

2. Click on the role.

3. Select the new role.

To change another user's future presence

1. Select the user.

2. Click on the Activity message.

3. Select Future presence... from the menu to see and set the future presence for the user.

To change another user's personal note

1. Select the user.

2. Click on the personal note.

3. Enter the new message.

7.4. Overriding Nightmode
The Override Nightmode menu option gives the possibility to extend the office hour function
of call routing by two hours. If the system has been configured for night mode, calls may not
be routed in the same way as during normal working hours. This option is only available for
authorized user defined by your System Administrator.

7.5. Options
The options menu is divided into four areas; account settings, audio settings, general and
advanced settings. The options menu is reached by selecting Tools > Options in the menu.

7.5.1. Account
• Logout - will log you out from the application and will take you to the activation screen.
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7.5.2. Audio Profile Settings
The Audio Profile Settings let you configure your audio settings when using the application
as a speaker phone, or with a headset. You can also configure a custom ringtone.

7.5.2.1. Speaker profile

The Speaker Settings tab is used to configure the sound devices the application will use in
the Speaker Profile. Use the Speaker Profile when using your computer as a speaker phone.

You can select the audio devices that should be used in the Speaker Profile. We recommend
to select the audio device that is connected to the computer speakers.

7.5.2.2. Headset profile

The Headset Settings tab is used to configure the sound devices the application will use in
the Headset Profile. Use the Headset Profile when using your computer with a headset.

You can select the audio devices that should be used in the Headset Profile. For Input and
Output, select the audio device that is connected to the computer's headset. This audio de-
vice typically belongs to a connected USB headset. For the Ringer device, select an audio
device that is connected to the computer speakers.

7.5.2.2.1. Supported headsets

The application work with most headsets, USB connected or wireless. However, if you also
want to use features (apart from volume control) from a headset to control the calls, headsets
from Plantronics and from Jabra are supported. Plantronics headset support is included for
PC and Mac and Jabra headset support is included for PC. Note that Plantronics does not
support Bluetooth connection with PC or Mac and that Jabra headsets are not supported on
Mac. Depending on headset model you will get different supported features. All headsets
support answering call, hanging up a call and receiving a second incoming call. Depending
on model you can also get functions such as reject call, hold, swap between ongoing calls,
mute, ringtone in headset, caller ID in addition to the headset volume control.

The headset SDK implementation is towards Plantronics Hub 3.8 (PC+Mac) and Jabra Direct
version 3.0 (PC), so basic functionality for all headsets that have support for those SDKs
should work.

7.5.2.3. Audio settings

The following settings are configured for each profile:

• Input audio device (the audio device to which the microphone is connected to)

• Output audio device (the audio device to which the speaker or headphone is connected to)

• Ringer audio device (this audio device will be used to play ring signals).

Note

The ringer audio device should not be connected to headphones since ringing
signals will not be heard unless the headphones are worn.

7.5.2.4. Ringtone

You can set a custom ringtone to differentiate your phone from the other phones in the office.

To change the ringtone

1. Select Tools > Options and click the Ringtone drop down-list.
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2. Select Choose, to browse for a new ringtone.

Tip

You can press the play button next to the drop down-list to listen to your cur-
rent ringtone

7.5.3. General settings
The general settings can be found by clicking Tools > Options .

7.5.3.1. Automatically start when the computer starts

This setting allows the application to be started when the computer is powered on. Autostart
is selected by default.

7.5.3.2. Automatically answer incoming calls

This setting makes it possible to have the application answer incoming calls automatically
without any active interaction from the user. When in call, the calling party is placed in a
queue or will hear a line busy tone depending on server configuration.

7.5.3.3. Integrate with Microsoft Outlook

Mark the checkbox if you want to integrate the softphone with Outlook 2003/2007/2010. This
will let you get search results from Outlook. Incoming calls will also be matched against
contacts in Outlook.

7.5.3.4. Popup for incoming call

This setting makes the application to pop up in the foreground for incoming calls.

7.5.3.5. Configure keyboard bindings

Pressing the Keyboard button will open the Keyboard bindings dialog. This dialog shows
all current keyboard shortcuts. It is also possible to reassign keyboard shortcuts for all the
commands.

7.5.4. Advanced Settings

7.5.4.1. Handle Callto and Tel URL calls

Callto links and Tel URLs on web pages are supported with Telia Touchpoint Flex Softphone.
Click a number with a callto or tel link and the application will automatically call the number
and connect you.

Note

If you have Skype installed, it will try to override your callto setting and handle
the call with Skype instead of with Telia Touchpoint Flex Softphone. Make sure
to start the application after Skype is started to solve this problem.

7.5.4.2. Use F8 to dial the selected number

Mark the checkbox if you want to call a selected number using the softphone just by pressing
F8. The softphone filter out non-valid characters automatically.
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7.5.4.3. Show queue information in standard view

Mark the checkbox if you want to show your group buttons and your queue information in
Standard view.

7.5.4.4. Automatic adjustment of microphone gain

Mark the checkbox if you want to have automatic adjustment of microphone gain. This can
prevent getting unwanted audio feedback.

7.5.4.5. Show extended search information

This will highlight the match on your search results so you see why the Contact appears in
your search. This is only available when logged into an attendant group.

7.5.4.6. Play sound for second incoming call

Play sound for second incoming call if you already are in a call.

7.5.4.7. Show extended target information in attendant view

This will enable extra information in the call item with information on whom the caller tried to
reach. For example, A user calls a person and ends up in the voicemail where the possibility
to press 1 to reach an attendant is played and used. Enabling extended target information
will then for the attendant picking up the call also publish in the call item from whom the caller
was diverted from.

This is only available when logged into an attendant group and using the attendant view.

7.5.4.8. Enable monitored calls and call control

This enables monitoring of your own ongoing calls, regardless of device. You can also start
and control calls made from another device from the application.

The following call activities are available:

• Start

• Hold

• Park

• Transfer

• Hang up

• Move to other device

7.5.4.9. Configure external applications:

You can configure external applications that will can be launched from within the application.
You can configure so that the application automatically launches on every incoming call or
so that you manually launch the application from the call. To configure external applications
go to Settings > Advanced > External....
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Use the +/- buttons to add or remove an External application.

7.5.4.9.1. Configuring your external application

To configure your external application, Double click the application you want to edit.
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Every application needs a name and a launch URI. The launch URI will be used when trying
to launch the application. For instance, launching a web browser use the http URI. http://
www.google.com. There are four special strings that you can use in your launch URI. These
special strings will be exchanged to the real value when there is an ongoing call.

Select the Auto-Launch option to make the application launch when receiving a call. Select
the Show shortcut option to make the application shortcut appear in every call.

• $CALLINGNAME. This will exchanged to the name of the calling person.

• $CALLINGNUMBER. This will be exchanged to the number of the calling person.

• $METATEXT. This will be exchanged to any Meta information available in the call for an
ACD or Attendant queued call.

• $TRANSFERREDBY. This will exchanged to information if this call was transferred by
anyone. It will be the name if the name is available otherwise the number.

Note

If the value isn't available in the current call the special string will be re-
moved. However any other information will still be there. For instance http://
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www.telepo.com?meta=$METATEXT will be http://www.telepo.com?meta= if
there is no METATEXT information.

7.5.4.9.2. Rewriting the values and testing

At the bottom of the configuration page there is a section where you can re-write the values.
For instance if your external application expects all numbers in national format but you know
that all incoming calls are in international format you can use these fields to re-write the val-
ues. You can use normal Regexp expression in the Match expression field. In the Replace
expression you put what value you want to replace it with. As an example, to exchange
Swedish numbers from an international format to national format use the \+46 value in the
Match expression field and a "0" in the Replace expression field.

The Test Value field can be used to test your expressions. Enter a value that you want to
test. The resulting URI will be shown at the bottom.

7.5.4.10. Edit call message templates

Pressing the Templates... button will open the Edit call message templates dialog. With this
dialog you can change the default call message templates for email and SMS. Your can also
reset the messages to its default values if needed. See also Section 9.10, “Send email and
SMS to a contact using call message templates” for more info on how and when to use this.

7.5.4.11. Email application

Choose whether to use "Microsoft Outlook" standard (semi-colon) or "Other" generic stan-
dard (comma) of separating email addresses when sending group emails.
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Chapter 8. Toolbar functions
8.1. Home

Clicking Home opens a web browser and the option to log on to the Telia Touchpoint Flex
Web. The Telia Touchpoint Flex Web contains different settings related to:

• Presence status - change settings for activities and roles

• Changing password - change your own password used to log in to the system.

• Overriding Nightmode

• Service configuration - call recording, call routing, fax and voice mail settings

• Conferencing configuration

• Contacts settings

• Log

Several of the settings are available as shortcut options from the toolbar.

8.2. Checking messages
The inbox contains all your messages in the system. The inbox is a filter in your Log. The
messages can be either voice mail, fax, or recordings.

To play or read a message

• Click the message.

To delete a message

• Select a message and click Delete selected.

8.3. Booking Conferences
The Conferences page is where you can schedule a voice meeting by inviting multiple par-
ticipants to the call. The page lists all meetings that have been scheduled.

To join an ongoing meeting

• Click Join meeting . You will automatically join the conference. If you select another an-
swerplace in the dropdown, the server will instead call you up on your selected phone and
join the conference.

You can also click on a meeting, call a meeting dial in number and then enter the Meeting
ID.

To add a new meeting

1. Click Add meeting .

2. Enter a name for the meeting.
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3. Select the start date, start time and meeting duration. The meeting timezone is your default
timezone. Check so that the meeting is booked in your preferred timezone.

4. If the meeting is recurring, select the recurrence in the Repeat drop down-list.

5. Set your preferred meeting reminder time to the calendar invitation.

6. Set the time for the SMS text message reminder.

7. Click Add participant .

8. Enter email, phone number or user's name to search for a participant. Click on the name
to add the contact to the meeting.

You can also click Add external participant if your preferred contact does not show up
in the list. Enter first name and phone or email to add the contact to the meeting. You can
mark the checkbox Remember contact if you want to remember the contact information
for other meetings.

Tip

You can remove a contact from the participant list by first clicking on the
contact's icon and then on Remove , or by clicking Remove participants and
then clicking on the participants to remove.

9. Write an invitation note. The text will be displayed in the invitation email and calendar
event.

10.Click Send invitations to send email invitations via the server. The email contains the
details of the meeting and how to dial in.

11.Click Close to close the meeting details.

To delete a meeting

1. Click on a meeting.

2. Click Remove .

3. OK .

8.4. Configuring Call Routing
The call routing rules are used to define how the system handle calls. Call routing rules are
set on the organization and group level and can also be set on the user level. Rules set on
the organization and group level are inherited by the user level and can been seen on the
call routing page.

Note

Depending on authorization settings on the organization and group level, you
might not have permission to override inbound and outbound rules.

The following types of call routing rules can be defined:

• Inbound rules - These rules are used to control how an incoming call is handled. This is
where the association between personal phone numbers and personal phones are defined,
that is, controlling which of the available phones that should ring when a call is received
to the personal number.
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• Outbound rules - These rules control how the system should behave when a call is placed.
For example to control which number that should be presented as a calling party number.
If no outbound rule exists the system will set the calling party number to private.

• Fallback rules - These rules control how incoming calls which cannot be connected are
handled. For example if the called party is busy the call may be diverted to voice mail.

8.4.1. Inbound Rules
Click Add to insert a new inbound rule. Follow the instructions on screen to build a new rule
with matching criteria and actions.

Table 8.1. Inbound rules match criteria

Match Criteria Description

Activity To match the current presence activity when
the call is received. For example, when an ac-
tivity is set to meeting a rule to forward calls
to voice mail can be created.

Availability To match the current availability when the call
is received. For example, when an unavail-
able activity is set a rule to forward calls to
voice mail can be created.

Call is tagged To match against what the call is tagged with.
This is mainly a technical rule.

Call's destination To match against line type set on the primary
and secondary line.

Calling party To match the type of calling party. This can
be: internal, external, favourite, blocked, VIP.
This allow rules treating callers differently.
VIP contacts match rules both for VIP and for
favourites.

Call's destination is tagged To match against what the call's destination
is tagged with. This is mainly a technical rule.

Call's source is tagged To match the call's source towards a list of
tags. This is mainly a technical rule.

Date To match a date. The possible values are be-
fore, after or a specific date.

Day of week To match a weekday. It is possible to speci-
fy "is" or "is not" and then provide the day of
week.

Diverted To match on calls that have been diverted
by one user to another number while using
the "Enter number:" setting. A call forked to
a user's own devices is not considered a di-
version.

Dialing number To match the dialed number against a set of
defined number types, for example interna-
tional or mobile.

Incall To match the call status. Possible values are
true and false. This rule allows specifying
what should happen if you are busy on a
phone when receiving a call.
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Match Criteria Description

Nightmode To match the Nightmode state. Possible val-
ues are True and False. This rules allows
specifying what should happen when Night-
mode is active or not. For example, should
calls be forwarded to a mobile when a call is
received during Nightmode.

Role To match the current presence role when the
call is received. This rule allows for example,
forwarding calls to attendant if role is set to
private. Possible values are the roles config-
ured for the organization.

Time To match a time value. Possible values are
before or after a specified time.

Inbound rules actions defines destinations where to forward the call. Some of the destinations
allow multiple destinations to be specified. It is also possible to define the delay when the
call will be redirected to other destinations. The following inbound rule actions are available:

Table 8.2. Inbound Rules Actions

Action/Destination Description (If the rule is matched...)

Desktop phone the call should be forwarded to the desktop
phone.

Lync application that call should be forwarded to the lync ap-
plication.

Analog phone the call should be forwarded to an analog
phone.

Mobile phone the call should be forwarded to the mobile
phone.

Queue the call should be forwarded to the person-
al queue. This action is typically used in con-
junction with the Incall match criteria. It is on-
ly possible to distribute a call that has been
in a personal queue to internal extensions. If
a rule with an external number distribution is
available the call will not be distributed to the
external number.

Active diversion number the call should be redirected to the redirect
number set by the feature code. Rules con-
taining this action will only match if an active
call diversion set by a feature code exists.

Telia Touchpoint Flex Softphone the call should be forwarded to the Telia
Touchpoint Flex Softphone.

Switchboard the call should be forwarded to the switch-
board number.

Voicemail the call should be forwarded to the voicemail
inbox.

Voicemail play activity the call should play current activity and then
call forwarded to the voicemail.

Voicemail play busy in call the call should play activity busy in call and
then call forwarded to the voicemail.
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Action/Destination Description (If the rule is matched...)

Voicemail play out of reach the call should play activity out of reach and
then call forwarded to the voicemail.

Enter phone number... the call should be forwarded to a custom
phone number added to the rule.

External PBX phone the call should be forwarded to the desk
phone that is behind a PBX connected to the
system.

Play activity the call will play current activity.

Send ringing a ringing tone will be played.

Send busy response a busy tone will be sent to the calling party.

Send decline response a decline tone will be sent to the calling party.

8.4.2. Outbound Rules
Click Add to insert a new outbound rule. Follow the instructions on screen to build a new
rule with matching criteria and actions.

Table 8.3. Outbound Rules Match Criteria

Match Criteria Description

Call is tagged To match against what the call is tagged with.
This is mainly a technical rule.

Called party To match the type of calling party, internal or
external. This allow rules treating internal and
external calls differently.

Call's destination is tagged To match the call's destination towards a list
of tags. This is mainly a technical rule.

Call's source is tagged To match the call's source towards a list of
tags. This is mainly a technical rule.

Date The possible values are before, after or a spe-
cific date.

Day of week It is possible to specify "is" or "is not" and then
provide the day of week.

Dialed number To match the dialed number against a set of
defined number types, for example interna-
tional or mobile.

Diverted To match on calls that have been diverted
by one user to another number while using
the "Enter number:" setting. A call forked to
a user's own devices is not considered a di-
version.

Nightmode To match the Nightmode state. Possible val-
ues are True and False. This rules allows
specifying what should happen when Night-
mode is active or not. For example, should
calls be forwarded to a mobile when a call is
received during Nightmode.

Role To match against the current presence role.
Possible match values are the roles config-
ured for the organization.
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Match Criteria Description

Time To match a time value. Possible values are
before or after a specified time.

The outbound rules actions are either used to specify the calling party number to be displayed
for the placed call or to block a placed call for different reasons. The following outbound rule
actions are available:

Table 8.4. Outbound Rules Actions

Action Description (If the rule is matched...)

Blocked because of forbidden destination the call will be blocked and instead the caller
will hear a prompt informing the reason for
blocking the call.

Blocked because of restricted time the call will be blocked and instead the caller
will hear a prompt informing the reason for
blocking the call.

Blocked because of unauthorized user the call will be blocked and instead the caller
will hear a prompt informing the reason for
blocking the call.

Placed from anonymous line the calling party number will be hidden for the
placed call.

Placed from billing id line the calling party number will be the billing id
line.

Placed from personal office line the calling party number will be set to the
number configured as the primary personal
number for the user.

Placed from external system the calling party number will be set to the
number configured on the external system.

placed from the calling party number will be set to the
function number chosen in the next dropdown
list.

Placed from secondary office line the calling party number will be set to the
number configured as the secondary person-
al number for the user.

Placed from switchboard line the calling party number will be set to the
switchboard number of the organization.

Redirected to switchboard the caller will be redirected to the switchboard
number instead of connected to the dialled
number.

8.4.3. Fallback Rules
Click Add to insert a new fallback rule. Follow the instructions on screen to build a new rule
with matching criteria and actions.

Table 8.5. Fallback Rules Match Criteria

Match Criteria Description

Calling party To match the type of calling party. This can
be: internal, external, favourite, blocked, VIP.
This allow rules treating callers differently.
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Match Criteria Description

VIP contacts match rules both for VIP and for
favourites.

Date To match a date. The possible values are be-
fore, after or a specific date.

Day of week To match a weekday. It is possible to speci-
fy "is" or "is not" and then provide the day of
week.

Time To match a time value. Possible values are
before or after a specified time.

The following actions are available for fallback rules.

Table 8.6. Fallback Rules Actions

Action Description

Fallback to switchboard on no answer after
30 seconds

If the called party has not answered within
30 seconds, the call will get diverted to the
switchboard number.

Fallback to switchboard on busy If the called party is busy in a call the call, will
get diverted to the switchboard number.

Fallback to switchboard on call rejected If the called party declines an incoming call
the call will get diverted to the switchboard
number.

Enter phonenumber... on call rejected If the called party declines an incoming call
the call will get diverted to the entered phone
number.

Send busy response on busy If the called party is busy, the calling party will
hear busy tone.

Send failure response on failure If the call fails the error cause will be forward-
ed to the calling party.

8.4.4. Rule Order
Each rule defined is added to an ordered list. When a rule is processed the system start
evaluating the match criteria of the first rule in the list. If the rule has no match, the system
continues down the list until a match is found.

It is possible to change the rule order using the up and down arrows.

8.5. Future presence
With future presence you can schedule presence events.

To add a new future event press +. Add your info, period and if the event should be repeated.

You can map diversions to the activity from the Activity Diversion setting.
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Chapter 9. Attendant Functionality

9.1. Attendant View
The Attendant view contains the calling view with incoming and ongoing calls to the left, the
contact list view to the right and the attendant groups and their status on the top. The call
handling function is the same in the attendant view as in the standard view. However, as an
attendant you can also camp-on calls to busy extensions.

To switch to the Attendant view

• In the menubar, select View > Attendant view.

9.2. Extended search
When logged into a distribution group, you also have the extended search feature activated
by default as an attendant. This will enable you to quickly find whom you are looking for as
you see what field that matches from your search query on your search results.

Extended search is enabled on both standard view and attendant view. You enable or disable
the extended search from the advanced settings in the preferences.

9.3. Queue Handling
The top of the view presents the attendant and ACD groups you belong to, if you are logged
in or out, and agent status. The number of available agents and calls in queue are displayed
in in the form (number of calls waiting [logged in agents/available agents]). If calls are in
queue in a group, the waiting time for the first call is also shown. If you have logged in to an



Chapter 9. Attendant Functionali-
ty

Revision: 4.7.15.46 52

attendant group you are able to pick up calls for the attendant group. It is also possible to
see the number of calls in the queue and the time for the first call in the queue.

9.3.1. Queue distribution
There are a few settings that affect how the queue is being handled and how calls are being
distributed. These settings are controlled by the administrator. This section lists a few of
these settings.

9.3.1.1. Destination of calls

The administrator can set which types of devices the calls are distributed to. Your own per-
sonal call routing rules will not apply for distribution of calls.

9.3.1.2. Distribution of calls

The administrator can set after how many seconds the call should go to the next attendant or
agent. Also if the presence state affects the distribution of the calls. That means if no atten-
dants or agents are logged in and in the Available presence state, the call will be forwarded
to a pre-set number.

9.3.1.3. Queue overflow for incoming calls

Queue overflow happens when a pre-set amount of users in the queue are exceeded, or if
the maximum waiting time is exceeded. When any of this happens the incoming call either
gets a busy tone or is forwarded to another pre-set number.

9.3.1.4. Handling of queued calls

Queued calls can be forwarded to a pre-set number when the caller has been waiting in
queue more than a set number of minutes. If no attendant or agent is logged in and is in
the available state the queued call can also be forwarded to a set number. If the configured
number of distribution attempts have been exceeded, the queued call can be forwarded to
the no attendant number.

9.3.1.5. Missed calls

The administrator can set so after a number of missed calls you are logged out of the dis-
tribution group.

9.4. Queue and Agent statistics tabs
An ACD supervisor who are authorized to supervise specific groups, can see the widgets
Queue statistics and Agent statistics for these groups. They appear as extra tabs in the
Standard view and the Attendant view . Using the widgets, the supervisor can see the
statistics for the groups, and log in and log out agents to these groups.

9.4.1. Queue statistics
The queue statistics widget shows all the ACD and attendant groups you are authorized to
supervise, and let you log in and log out agents to these groups. The statistics is presented
in the administrator configured running time span.
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• Group - The name of the group. Click on the group to expand it. When expanded, the
group provides: Agent members of the group, with logged out agents having names in
grey; Agent status; skill, where skill 1 is the highest and 5 the lowest skill; and a button to
log in or log out the agent to or from the group.

• # in queue - Number of persons in the queue.

• Last wait - The time in minutes:seconds the last picked up call waited before the call was
picked up.

• Avg wait - The time in minutes:seconds the average call in the configured time span waited
before the call was picked up.

• Dropped - The number of calls that were hang up by the callers before they were picked up.

9.4.2. Agent statistics
The agent statistic widget shows all the info provided by the Queue statistic widget, but it is
sorted by Agent name instead of group name. See Queue statistics for more information.

9.5. Group login
You can see your login status on the group buttons on top of the application window, and
login or logout by pressing the buttons.

The login/logout buttons are highlighted for the groups you are logged into.

•
 - You are logged in to the group. Click to logout.

•
 - You are logged out from the group. Click to login.

9.6. Transfer Calls
There are certain keyboard shortcuts that are only available when viewing the application in
Attendant view. They are meant to speed up the call handling. All keyboard shortcuts are
customizable in the Settings > General >  Keyboard... section. There are 2 different options
to transfer calls.

9.6.1. Blind transfer
When answering a call the focus will automatically be set to the search field. To start a blind
transfer search for a contact or enter a number that the call should be transferred to.

• If the search result is only one contact or number then press the Blind Transfer key to
transfer the call.

• If the search result returns multiple contacts then navigate the contact list using the Navi-
gate Contacts Up/Down keys and make sure the contact you want to transfer to has the
selection marker. Press the Blind Transfer key to transfer the call.

Note

If you have multiple ongoing calls when doing a blind transfer it will pick the active
call to transfer. If there are no active calls you have to select the call by Using
the Navigate Calls Up/Down keys.
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9.6.2. Attended transfer
When answering a call the focus will automatically be set to the search field. To start an
attended transfer, place a call to a contact or a number that the first call should be transferred
to.

• If there are only two ongoing calls then press the Attended Transfer key to transfer the
calls.

• If there are multiple ongoing calls then navigate the Calls list using the Navigate Calls Up/
Down keys and make sure the call you want to transfer to has the selection marker. Press
the Attended Transfer key to transfer the call.

9.7. Camp-On
Camp-on is an attendant functionality which allows you to transfer a call to a busy user. If the
user is busy with a call, a personal queue is created, which the transferred call is put on hold
in. When the user's first call is ended, the transferred call in the personal queue is connected.

Note

Camp-on is only possible to do for calls that has been made to a attendant group
number.

Camping-on a call is made the same was as a normal transfer. The only difference is that a

camp-on icon  is displayed on busy extensions instead of the normal transfer call icon.

It is possible for an administrator to set a maximum waiting time, for the transferred calls that
has not been picked up, before the attendant is notified that the call has not been picked
up. It is also possible to notify all attendants in the attendant group after a set maximum
waiting time.

If the call remains on hold too long in the queue, and an attendant picks up the call, it is
possible to re-camp the call into the queue again. The call is then put back in the queue in
the kept queuing position.

To re-camp a call

•

Click . You can also press the Return key on your keyboard.

Note

If you camp-on the call normally and not via the re-camp button, the call will
not keep its queuing position and will be placed last in the queue.

9.8. Transferred calls
During a transfer, new incoming calls will be placed in the queue. They will not be automat-
ically routed to you until the transfer is complete. You can pick up a new call in the queue
by clicking on the pick up button.

If a transfer has failed, you will get notified and can pick up the call again. This could be,
for example, if the contact you transferred the call declined to answer. The call will then
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be placed on hold, and the call will flash in the call view to let you know this call requires
immediate attention.

9.9. SMS messages
You can send SMS messages with the attendant number as from number, if this is configured
on the server. See Section 5.3, “Messaging” for more information.

9.10. Send email and SMS to a contact using
call message templates

This is an attendant functionality which allows you to send an email or SMS to a contact with
pre-filled information about the current call. The pre-defined template text that is used for this
can be changed in the Options dialog.

The email will be created with your default email client application, and will have the email
template text pre-filled in its subject and content. The SMS will be sent using the functionality
in the application, and will be pre-filled with the SMS template text.

Note

You need to be logged in to an attendant group to be able to use this functionality.

9.10.1. Send email or SMS when received a diverted
call

When you receive a call from a contact that tried to reach another contact that diverted the

call to you, you can click the  button to create a new email, or the  button to create
a new SMS in the call panel.

9.10.2. Send email or SMS during an ongoing call

During an ongoing call, you can send an email or SMS using the button  to create a

new email, or the  to create a SMS for a contact in your contact list. You can also use
the search functionality to send to a contact that is not currently in your contact list.
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Chapter 10. ACD Functionality
10.1. ACD Agent View

The ACD Agent View contains the menu and the call information field with the possibility to
dock the field to the top or the bottom of the screen. The call handling function is the same
in the ACD Agent view as in the standard view.

To switch to the ACD Agent view

• In the menu bar, select View > ACD Agent view.

10.2. Queue Handling
The top of the view presents the attendant and ACD groups you belong to, if you are logged
in or out, and agent status. The number of available agents and calls in queue are displayed
in in the form (number of calls waiting [logged in agents/available agents]). If calls are in
queue in a group, the waiting time for the first call is also shown. If you have logged in to an
attendant group you are able to pick up calls for the attendant group. It is also possible to
see the number of calls in the queue and the time for the first call in the queue.

10.2.1. Queue distribution
There are a few settings that affect how the queue is being handled and how calls are being
distributed. These settings are controlled by the administrator. This section lists a few of
these settings.

10.2.1.1. Destination of calls

The administrator can set which types of devices the calls are distributed to. Your own per-
sonal call routing rules will not apply for distribution of calls.

10.2.1.2. Distribution of calls

The administrator can set after how many seconds the call should go to the next attendant or
agent. Also if the presence state affects the distribution of the calls. That means if no atten-
dants or agents are logged in and in the Available presence state, the call will be forwarded
to a pre-set number.

10.2.1.3. Queue overflow for incoming calls

Queue overflow happens when a pre-set amount of users in the queue are exceeded, or if
the maximum waiting time is exceeded. When any of this happens the incoming call either
gets a busy tone or is forwarded to another pre-set number.
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10.2.1.4. Handling of queued calls

Queued calls can be forwarded to a pre-set number when the caller has been waiting in
queue more than a set number of minutes. If no attendant or agent is logged in and is in
the available state the queued call can also be forwarded to a set number. If the configured
number of distribution attempts have been exceeded, the queued call can be forwarded to
the no attendant number.

10.2.1.5. Missed calls

The administrator can set so after a number of missed calls you are logged out of the dis-
tribution group.

10.3. Queue and Agent statistics tabs
An ACD supervisor who are authorized to supervise specific groups, can see the widgets
Queue statistics and Agent statistics for these groups. They appear as extra tabs in the
Standard view and the Attendant view . Using the widgets, the supervisor can see the
statistics for the groups, and log in and log out agents to these groups.

10.3.1. Queue statistics
The queue statistics widget shows all the ACD and attendant groups you are authorized to
supervise, and let you log in and log out agents to these groups. The statistics is presented
in the administrator configured running time span.

• Group - The name of the group. Click on the group to expand it. When expanded, the
group provides: Agent members of the group, with logged out agents having names in
grey; Agent status; skill, where skill 1 is the highest and 5 the lowest skill; and a button to
log in or log out the agent to or from the group.

• # in queue - Number of persons in the queue.

• Last wait - The time in minutes:seconds the last picked up call waited before the call was
picked up.

• Avg wait - The time in minutes:seconds the average call in the configured time span waited
before the call was picked up.

• Dropped - The number of calls that were hang up by the callers before they were picked up.

10.3.2. Agent statistics
The agent statistic widget shows all the info provided by the Queue statistic widget, but it is
sorted by Agent name instead of group name. See Queue statistics for more information.

10.4. Group login
You can see your login status on the group buttons on top of the application window, and
login or logout by pressing the buttons.

The login/logout buttons are highlighted for the groups you are logged into.

•
 - You are logged in to the group. Click to logout.

•
 - You are logged out from the group. Click to login.
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10.5. Manager Assistance
When logged on as an ACD Agent it is possible to request assistance from a manager by
calling a predefined number.

Click Help Me in the ACD Agent view to call for manager assistance.

10.6. SMS messages
You can send SMS messages with the ACD number as from number, if this is configured on
the server. See Section 5.3, “Messaging” for more information.
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Chapter 11. Troubleshooting
11.1. My administrator has added me to an
ACD or Attendant group but I cannot see the
login button.

You need to restart your application for the updates to load.



Chapter 12. About

Revision: 4.7.15.46 60

Chapter 12. About
Copyright © 2004-2016 Mitel Communications AB. www.mitel.com


	Telia Touchpoint Flex Softphone
	Table of Contents
	Chapter 1. Getting Started
	1.1. Installing
	1.1.1. Security settings

	1.2. Activation process

	Chapter 2. Getting to know the application
	2.1. Overview
	2.2. Icons
	2.3. Tray Icon

	Chapter 3. Calling
	3.1. Call Panel Overview
	3.2. Line state
	3.3. Placing a call
	3.3.1. Caller ID
	3.3.2. Normal call
	3.3.3. Intercom call
	3.3.4. Advanced calling options
	3.3.4.1. Bypass diversion rules
	3.3.4.2. Intrude ongoing call
	3.3.4.3. Call As
	3.3.4.4. Call With

	3.3.5. Callto and Tel URL calls

	3.4. Receiving A Call
	3.5. Hanging Up or Rejecting a Call
	3.6. Holding a Call
	3.7. Parking a Call
	3.8. Transfer a Call
	3.8.1. Blind Transfer
	3.8.2. Attended transfer
	3.8.3. Camp-On
	3.8.4. Failed transfer

	3.9. Move to Client
	3.10. Sending DTMF tones
	3.11. Recording a Call
	3.12. Conference Calls
	3.12.1. Creating a Conference Call
	3.12.2. Disconnecting Participants
	3.12.3. Ending a conference Call

	3.13. Log
	3.14. Calling from Microsoft Office Applications
	3.14.1.  Setting up the Telia Touchpoint Flex Softphone in Microsoft Word, Powerpoint or Excel

	3.15. Volume control
	3.16. Remote call control for calls with another phone
	3.16.1. Supported features and limitations


	Chapter 4. Contacts
	4.1. Favourites, VIPs and Blocked contacts
	4.2. Adding contacts
	4.3. Removing contacts
	4.4. Edit contacts
	4.5. Exchange calendar

	Chapter 5. Chat, Collaboration and Messaging
	5.1. Chat
	5.2. Collaboration
	5.2.1. Advanced chat
	5.2.1.1. Individual chat
	5.2.1.2. Group chat
	5.2.1.3. Chat options
	5.2.1.4. Adding files

	5.2.2. Pages
	5.2.3. To-Do
	5.2.4. Meet

	5.3. Messaging
	5.3.1. SMS messages
	5.3.2. Email messages


	Chapter 6. MiTeam: Streams and Meets
	6.1. Streams
	6.1.1. Stream options
	6.1.2. Chat
	6.1.3. Adding files
	6.1.4. Pages
	6.1.5. To-Do

	6.2. Meets

	Chapter 7. Settings
	7.1. Presence
	7.1.1. Activities
	7.1.1.1. Presence shortcut
	7.1.1.2. Custom Activity
	7.1.1.3. Future presence
	7.1.1.4. Activity diversion


	7.2. Personal Note
	7.3. Changing another user's presence information
	7.4. Overriding Nightmode
	7.5. Options
	7.5.1. Account
	7.5.2. Audio Profile Settings
	7.5.2.1. Speaker profile
	7.5.2.2. Headset profile
	7.5.2.2.1. Supported headsets

	7.5.2.3. Audio settings
	7.5.2.4. Ringtone

	7.5.3. General settings
	7.5.3.1. Automatically start when the computer starts
	7.5.3.2. Automatically answer incoming calls
	7.5.3.3. Integrate with Microsoft Outlook
	7.5.3.4. Popup for incoming call
	7.5.3.5. Configure keyboard bindings

	7.5.4. Advanced Settings
	7.5.4.1. Handle Callto and Tel URL calls
	7.5.4.2. Use F8 to dial the selected number
	7.5.4.3. Show queue information in standard view
	7.5.4.4. Automatic adjustment of microphone gain
	7.5.4.5. Show extended search information
	7.5.4.6. Play sound for second incoming call
	7.5.4.7. Show extended target information in attendant view
	7.5.4.8. Enable monitored calls and call control
	7.5.4.9. Configure external applications:
	7.5.4.9.1. Configuring your external application
	7.5.4.9.2. Rewriting the values and testing

	7.5.4.10. Edit call message templates
	7.5.4.11. Email application



	Chapter 8. Toolbar functions
	8.1. Home
	8.2. Checking messages
	8.3. Booking Conferences
	8.4. Configuring Call Routing
	8.4.1. Inbound Rules
	8.4.2. Outbound Rules
	8.4.3. Fallback Rules
	8.4.4. Rule Order

	8.5. Future presence

	Chapter 9. Attendant Functionality
	9.1. Attendant View
	9.2. Extended search
	9.3. Queue Handling
	9.3.1. Queue distribution
	9.3.1.1. Destination of calls
	9.3.1.2. Distribution of calls
	9.3.1.3. Queue overflow for incoming calls
	9.3.1.4. Handling of queued calls
	9.3.1.5. Missed calls


	9.4. Queue and Agent statistics tabs
	9.4.1. Queue statistics
	9.4.2. Agent statistics

	9.5. Group login
	9.6. Transfer Calls
	9.6.1. Blind transfer
	9.6.2. Attended transfer

	9.7. Camp-On
	9.8. Transferred calls
	9.9. SMS messages
	9.10. Send email and SMS to a contact using call message templates
	9.10.1. Send email or SMS when received a diverted call
	9.10.2. Send email or SMS during an ongoing call


	Chapter 10. ACD Functionality
	10.1. ACD Agent View
	10.2. Queue Handling
	10.2.1. Queue distribution
	10.2.1.1. Destination of calls
	10.2.1.2. Distribution of calls
	10.2.1.3. Queue overflow for incoming calls
	10.2.1.4. Handling of queued calls
	10.2.1.5. Missed calls


	10.3. Queue and Agent statistics tabs
	10.3.1. Queue statistics
	10.3.2. Agent statistics

	10.4. Group login
	10.5. Manager Assistance
	10.6. SMS messages

	Chapter 11. Troubleshooting
	11.1. My administrator has added me to an ACD or Attendant group but I cannot see the login button.

	Chapter 12. About

